
 

  NGC™  
  ChromLab™ 

    
 3.3 

 



 



  
NGC™   

 ChromLab™ 

   
 

 3.3 

 



    Bio-Rad 

    Bio-Rad       
,  05:00:00  17:00 (   ).  

      -  www.consult.bio-rad.com. 

: 1-800-424-6723, . 2 

- : www.consult.bio-rad.com 

Email: Support@Bio-Rad.com (   / ) 

           
   . 

 

           
 ,   ,  , 

,    -     , 
   Bio-Rad Laboratories . 

 Bio-Rad            
  .        

 .     
,  Bio-Rad       , 

     . 

PEEK     Victrex PLC. Tefzel   
  E.I. du Pont de Nemours and Co. 

Capto, GSTPrep, GSTrap, HiLoad, HiPrep, HiScreen, HisPrep, HisTrap, HiTrap, MabSelect, 

MBPTrap, Mini Q, Mini S, Mono P, Mono Q, Mono S, RESOURCE, Sephacryl, Sepharose, 

SOURCE, StrepTrap, Superdex, Superose  Xtra    
 General Electric Company      . 

  GE   NGC  Bio-Rad   
 GE. 

Ав к е ав  © 2015 Bio-Rad Laboratories, Inc. В е ава ащ ще ы. 



      |   iii 

  

 1.  .............................................................................................11 

  NGC .................................................................................... 12 

  ..................................................................................................... 13 

    .............................................................................................. 14 

   ................................................................................................... 14 

  ..................................................................................................... 15 

  ....................................................................................................... 15 

   ................................................................................. 16 

   ................................................................................. 16 

   ................................................................................. 16 

  ..................................................................................................................... 17 

 2.  NGC  .......................................................................................19 

  NGC  ................................................................................................. 20 

  ...................................................................................................................... 22 

  .......................................................................................................................... 24 

  ........................................................................................................................ 25 

  .......................................................................................................................... 26 

    NGC Discover Pro .............................................. 27 

 .................................................................................................................................... 28 

  ........................................................................................................... 29 

  ....................................................................................... 30 

    ...................................................... 30 

   ...................................................................................... 30 



 

iv   |     NGC™    ChromLab  

   ........................................................................................................... 33 

  ....................................................................................... 34 

     ..................................................... 34 

     ....................................................................... 34 

 .................................................................................................................................. 36 

  ..................................................................................................... 37 

  ....................................................................................... 37 

   .................................................................................. 38 

    ............................................... 39 

    ................................................................. 39 

     ............................................. 39 

     .......................................................... 42 

  ....................................................................................... 43 

      ....................................... 44 

       .... 44 

       ...................... 45 

  ............................................................................................................. 46 

  .......................................................................................................... 47 

  ....................................................................................... 47 

   ........................................................................................... 48 

    ........................................................ 49 

    .......................................................................... 50 

 .............................................................................................................. 51 

  ....................................................................................... 52 

   ......................................................................................... 52 

    ...................................................... 53 

    ........................................................................ 54 

  к  ....................................................................................... 55 

  ....................................................................................... 56 

    ..................................................................... 57 

    к  .................................. 58 

     .................................................... 58 

      ................................ 59 

 .............................................................................................................................. 61 

  ....................................................................................... 63 

   ..................................................................... 64 



 

      |   v 

 ............................................................................................................................... 64 

-    ............................................................ 64 

 -  ..................................................................................... 66 

   ............................................................ 68 

  ................................................................................. 69 

   ...................................................................................... 70 

  ...................................................................................... 71 

 pH  ..................................................................................................................... 72 

  ....................................................................................... 73 

  pH ...................................................................................................... 73 

   pH .................................................................................. 74 

      pH ........................... 75 

, ,    ........................................................................................ 76 

 ............................................................................................................................... 76 

  ..................................................................................................... 77 

 ............................................................................................................................. 77 

 ............................................................................................................................. 78 

     .......................................................... 79 

 ................................................................................................................................... 80 

  ............................................................................................................... 80 

    ......................................................... 82 

        ........................... 82 

  ............................................................................................................ 83 

  ........................................................................................................ 83 

  NGC  ......................................................................................................... 84 

   ................................................................................................................ 85 

  NGC ................................................................................................ 86 

 3.   ..........................................................................89 

  ....................................................................................................................... 90 

   NGC  ..................................................................... 90 

     NGC  ...................................................... 92 

   NGC Scout ................................................................... 93 

   NGC Discover............................................................... 93 

   NGC Discover Pro ........................................................ 93 



 

vi   |     NGC™    ChromLab  

        .............................................. 94 

   ........................................................................................................ 94 

    ........................................................................................ 94 

   .................................................................................. 95 

      ..................................................... 96 

  .......................................................................................................... 97 

-  .................................................................................................................... 97 

   .............................................................................................. 98 

    ............................................................................ 100 

        .............................. 101 

    ..................................................................... 102 

     NGC............................................................. 104 

-      ................................... 104 

     NGC  ............................................................ 105 

     NGC ................................................................. 105 

  SIM   NGC ................................................................... 105 

     SIM ......................................................... 107 

  NGC ........................................................................................................... 114 

  NGC    ChromLab ..................... 115 

      Point-to-Plumb ............................... 116 

    ......................................................................................... 118 

    NGC Quest  ............................................................. 119 

    NGC Scout  ............................................................. 122 

  NGC Scout ............................................................................. 122 

  NGC Scout ................................................................................ 124 

    NGC Discover  ........................................................ 126 

  NGC Discover  ....................................................................... 126 

  NGC Discover  .......................................................................... 133 

          ....... 139 

  ............................................................................................................. 140 

     NGC ....................................................... 141 

    ................................................................................... 142 

  ............................................................................................................. 143 



 

      |   vii 

  NGC ................................................................................................... 145 

  pH .............................................................................................. 145 

   ..................................................................... 146 

 « »   ......................................................................... 146 

   ............................................................. 147 

     ............................... 149 

    NGC .................................................................. 150 

    NGC  ................................................................... 150 

  NGC ...................................................................................................... 151 

    ....................................................... 152 

      .......................................................... 155 

      ........................................................................... 156 

  NGC ............................................................................................. 156 

    ............................................................................................ 157 

     ......................................................................... 158 

  .......................................................................................................... 159 

   ...................................................................................... 159 

    ............................................................... 169 

  ..................................................................................................... 170 

  .............................................................................................................. 175 

  .................................................................................................... 175 

    ............................................................... 176 

   ...................................................................................... 178 

    .............................................. 181 

   ...................................................................................... 185 

 ............................................................................................................................ 186 

   ................................................................................... 186 

  ................................................................................................. 188 

  .................................................................................................... 194 

 ............................................................................................................................. 196 

   -  ...................................................................... 196 

    -  ........................................ 201 

    ................................................................................ 208 



 

viii   |     NGC™    ChromLab  

     ..................................... 209 

   .................................................................... 214 

 pH ............................................................................................................................. 217 

 pH-  ................................................................................................. 217 

 pH-  ................................................................................................... 217 

  pH ......................................................................................................... 218 

  .............................................................................................................. 220 

     NGC  ................................................... 220 

      NGC .................................................. 227 

       .......................... 231 

  .................................................................................................. 234 

   ...................................................................... 236 

    ................................................................... 238 

 B     ................................ 245 

      ........................................................................... 245 

-    ................................................................................... 253 

  .......................................................................................... 258 

 pH .......................................................................................................................... 259 

     .............................................................. 260 

  к  ........................................................................................... 260 

  ............................................................................................................ 261 

 C   ........................................................ 263 

  NGC .................................................................................................. 264 

      .......................................................... 264 

       NGC ................. 265 

   .................................................................... 269 

   .......................................................... 270 

  NGC Quest ............................................................................... 271 

  NGC Scout  ............................................................................... 274 

     NGC Discover  ............................... 278 

     NGC Discover Pro  ......................... 283 

    ................................................................ 285 

   .......................................................................... 286 



 

      |   ix 

 D   C-96   NGC ....... 289 

  C-96   NGC..................................................... 289 

  C-96   NGC ...................................................... 289 

    C-96 ......................................................... 292 

  C-96        
    ChromLab ....................................................................... 295 

 E   ................................................. 297 

   ......................................................................... 297 

        .   
    ......................................................................................................... 298 

  ( ) .......................................................................... 298 

        ........................... 299 

 F     
  NGC  ........................................................................... 301 



 

x   |     NGC™    ChromLab  

 



 

      |   11 

 1  

  NGC™   , 
     .  

      NGC   
    .     

  -      
     .   

        
  ,       

 .        ,  
 ,             

   .  ,    
         

. 



1   |    

12   |     NGC™    ChromLab  

  NGC 

  NGC    .   
      10 /  (  10)   

    100 /  (  100). 

     ChromLab™    
NGC. 

■   NGC Quest™ : 

□    

□  

□   

□     -  (  
 NGC Quest)     (  
 NGC Quest Plus) 

■   NGC Scout™ : 

□    NGC Quest 

 :  NGC Scout     -

,  NGC Scout Plus   
 . 

□  pH  

□      

■   NGC Discover™ : 

□    NGC Scout 

 :   NGC Discover    
 . 

□   к  

□      

□    



  

      |   13 

■   NGC Discover Pro : 

□    NGC Discover 

 :   NGC Discover    
 . 

□    

□    

□   

  

  NGC : 

■          
     

■       
       

■        
     ,   C-96 

■         
 (SIM)          

    

■          
        

BioFrac™ 

■       
    

■         
 ,       

 

■        
  

■    ,   ,  
       



1   |    

14   |     NGC™    ChromLab  

■       
     ,   

 

■    ,   
        

,        

■         Point-

to-Plumb™   ChromLab 

    

   

:   NGC     
      . 

  ,     ,   
  7   . 

 1.      NGC   ChromLab 
 

  

   100-240  . ; 50-60  

  
 

<750  

      : 
■     NGC 

■     ChromLab 

■      
BioFrac™ 

■     
  

 ( ,  C-96) 

:     
  . 

   IEC   



    

      |   15 

  

 NGC      4-40°C. 

   NGC      
 .         

,            
  . 

    ,     
       NGC  

  ChromLab. 

  

,  ,     NGC, 

    . 

         
  NGC    ChromLab. 



1   |    

16   |     NGC™    ChromLab  

   

     ,   
 .        

  . 

   

     ,   
    NGC. 

 

   

 

/ 
  

 ,    
    

.   ,  
       

. 

 

 
  

 ,    
    

.   ,  
       

. 

 

  ,    

    
 ,   
.   ,  

       
. 

 

    

 

!   NGC     ,  
  .       

      .     
        

    . 

 

!    NGC  , 
   .    , 

 ,       .  
        

      Bio-Rad. 



  

      |   17 

  

   NGC  DVD «   
 NGC»        NGC   « » 

(Help)     ChromLab. 

      NGC  
  ChromLab     : 

■      NGC   
 ChromLab   DVD «   

 NGC»    .pdf.     
,      NGC  , 

  ChromLab    ChromLab   NGC. 

■       NGC  
  ChromLab   DVD «  

  NGC»    .pdf.   
     ChromLab™    

  NGC,       
  ,    , 

  ,        
 . 

■   « » (Help)  ChromLab     
        

   .      « » 
(Help). 

■  NGC   DVD «   
 NGC»    .mp4. 

:    Bio-Rad        
ChromLab,      Bio-Rad 



1   |    

18   |     NGC™    ChromLab  

 



 

      |   19 

 2  NGC 

 NGC™      
,    .  

     ,   .  
    , ,   , -  .  

      ,    
 . 

     ,  
   ,     . , 
          
,        . 

           
         

 .       
   - ,      

   ChromLab™.     
ChromLab         

  . 

      ,    
 NGC. 



2   |    NGC  

20   |     NGC™    ChromLab  

  NGC 

       
  NGC Discover™ Pro. 

■   

■   

■   

■   

:         . 
    NGC Quest™, NGC Scout™  NGC 

Discover    9  . 86. 



  NGC  

      |   21 

     



2   |    NGC  

22   |     NGC™    ChromLab  

  

 



  NGC  

      |   23 

  

1     2    

3    4    

5  ,  6   

7   
 

8   

9   10  pH  

11     
  

12  

13    14   к  

15   B 16    
 

17 USB-    
   

18   B 

19  20  

21    
  

22   A 

23   A 24   

25    
 

  



2   |    NGC  

24   |     NGC™    ChromLab  

  

  

  

1 /    2    

3   
  

4   
  

5 /    6     

7    
  

8  Ethernet  

9    10    

11   12  ./ . 



  NGC  

      |   25 

  

  

  

1   2    
 

3    
 

4 USB-  

5    6  

7     8    

9     
  

  



2   |    NGC  

26   |     NGC™    ChromLab  

  

  

  

1    2   

3     4 USB-  

5    
 

6   
  

7     



  NGC  

      |   27 

    NGC Discover Pro 

   ChromLab       System 

Control (     Method Editor    ).   
           
 .         

NGC Discover Pro    .     
    . 

         
    

►          . 

     . 

:       ChromLab   
      NGC  

  ChromLab. 

  

    

1   A  B 2    
 A  B 

3    
  

4       

5    6     

7   8  (     ) 

9   10   к  

11  (    ) 12   
 

13   14   pH 

15   16   (  ) 

17  (     
) 

  



2   |    NGC  

28   |     NGC™    ChromLab  

 

 NGC      :   (  
)  (     B)     .  

          
      .    

         
   .      

    . 

 



 

      |   29 

  

        
  . 

  

  

1    
 

2    

3   4   

5  Purge/Pause  6    

7   8    



2   |    NGC  

30   |     NGC™    ChromLab  

  

 NGC    :   (  )   B 
(  ).       : 10 

/  (  F10)  100 /  (  F100). 

 F10 

■  : 0,001-10 /  

■   : 0–3650 ./ . . (0–25,2 M a) 

■  : 0,35-10  

 F100 

■  : 0,01-100 /  

■   : 0-1450 ./ . . (0-10 M a) 

■  : 0,35-10  

    

      . 

■   ,      . 

   

  NGC       F10,    
  F100. -     

      .   NGC Quest 

(      )    
 ,           

 . ,     F10   10 
/ ,     F10 B    0 / .   

     5 /     50% B,   
   B    2,5 /  . 



 

      |   31 

        Pause  
  Purge. 

■    Pause       
 .       Pause     

    ,    
. 

       ChromLab. 
       ,   

  . 

■   «Purge»       
,      .    

 ,    . ,    
         

,   B    .   
            

,     B.    
..        

Purge  . 

:      : 

□   

□        

□          
 

 

 

!      ,   
       .  
             

    . 

:        ChromLab    
 ,    ,     

ChromLab.           
  ChromLab,       (Waste)  

 .       
     NGC   

 ChromLab. 

    

           
   . 



2   |    NGC  

32   |     NGC™    ChromLab  

   

  NGC     20%   
   .     
           

. 

       ,    
,     ,   . 

         
 ,          

 (  ).        
         . 

          . 
          
. 

:     .   
           

    . ,    
       . 



 

      |   33 

   

          
      .   

        ,  
         

   . 

      ,   
       .  

        
  F100. 

       ,   
   .     
       . 

        «  
    »  . 96. 

  

  

1    
 

2    

3   4   

5  Purge/Pause  6    

7   8    



2   |    NGC  

34   |     NGC™    ChromLab  

  

■  : 0,01-100 /  

■  : 0-1450 ./ . . (0-10 M a) 

■  : 0,35-10  

     

      . 

■   ,      . 

     

-        
     .     

    Pause    Purge. 

■     Pause    . 
      Pause    , 

   . 

       ChromLab. 

       ,   
  . 

■   «Purge»        
,      .    

.        
Purge   . 

:         -

      . 
 

 

!      ,   
       . 



 

      |   35 

:        ChromLab    
 ,    ,     

ChromLab.           
  ChromLab,       (Waste)  

 .       
     NGC   

 ChromLab. 



2   |    NGC  

36   |     NGC™    ChromLab  

 

  NGC   . C  NGC   
     : 

■      

■     

■    

■   

■   к  

  (       ) 

       
   .    ,   
    .    

 .   ,    
    .   ,     

  .        
    . 



 

      |   37 

  

        
  . 

    ,      
    ,  

          
   . 

          
  ,    . 

 

  

■    – 3650 ./ . . 



2   |    NGC  

38   |     NGC™    ChromLab  

   

  

  

Inject       

Column       

Pump      

Loop E  ■   :    

■   :    

Waste 1     (       
) 

Sample pump       

Loop F  ■   :    

■   :    

Waste 2     (   ) 



 

      |   39 

    

      . 

■     ,     
 . 

■     ,       
. 

■         
  Point-to-Plumb™. 

    

      .  
   : 

■          
       . 

■          (  
)         

 . 

■      ,    
 (  ). 

     

   (Manual) (   System Control   ChromLab)   
          

  . 

        
 . 

  
 

     

     

      

   



2   |    NGC  

40   |     NGC™    ChromLab  

   

  /   –  

 

■     
    

■    
   ,  

     
.    
     

 (W1) 
■      

  
 

    /    –  

 

■     
    

  

■      
   (W2) 

■      
  

 



 

      |   41 

   

      /   –  

 

■     
   (W2) 

■      
   
    
  

■      
   

 

      /   –  

 

■     
    

■      
  .   
    

   (W1) 
■      

  
 



2   |    NGC  

42   |     NGC™    ChromLab  

     

        
   .      

       
       .   

         
  .       

        
     pH.    

   ,       
   . 

       .  
          

     8/BB     . 
 ,        

     ( ,  20 /   
  F10  200 /     F100). 

          
   ,   ,   , 

    .      
        

   . 



 

      |   43 

 

  

■   –  15 ./ . . 



2   |    NGC  

44   |     NGC™    ChromLab  

      
 

 

 

 

   

 
 

 

  
 

 

  

Q1-Q4       

Outlet A      A     
 A 

Outlet B      B     
 B 

      
 

        
 . 

■    ,     . 

■    ,     
       

. 

■      . 

■         

  Point-to-Plumb™. 



 

      |   45 

       

        : 
   . 

   

, ,       ,  
           

    .    

  : 

■ Q4 —    (   ) 

■ Q3 —  (   ) 

■ Q2 —  (   ) 

■ Q1 —  (   ) 

   Q1  Q2       
. 

  

        
    ,   

     .   ,  
     Q1  Q4,     
    . 

:         Q1  
Q4. 



2   |    NGC  

46   |     NGC™    ChromLab  

  

       
 .   ChromLab     

 : 

■          

■            

■         
    

         .  
       

     –    .   
ChromLab           

   . 

:    (Manual) (   System Control   ChromLab)  
        

   .       
         .  

      ,   
     /      

   .      
           
    . 



 

      |   47 

  

 

  

■   : 500 / . . 

■           
. 

        «  
»  . 80. 

:   ChromLab         
    . ,    , 

   ,    . 

        
   NGC    

ChromLab. 



2   |    NGC  

48   |     NGC™    ChromLab  

   
 

 

 

  

  

  

    
 

  

1-7    

8/BB 8:          

BB:         
  

Out   

   

        
 

  

1-8/BB    

Out      



 

      |   49 

        (S1  S2) 
 

   

S1  

S2 

1-7    

S1 

S2 

8/BB      2 

   

S1 

S2 

Out      

   S1 

    

     . 

■     ,     
 . 

■     ,       
. 

■         
  Point-to-Plumb™. 

■   Outlet    . 

■      ,    
  . 

■      ,    
   S2: 

□     Outlet. 

□        S2. 

□    8/BB   S1. 



2   |    NGC  

50   |     NGC™    ChromLab  

    

     ,    . 
 ,    ,    

     .  , 
    ,      

  . 

    

 NGC       . 
     ,    

    ,     
  .      

       
 .      

        
   .      

      8/BB   .  
        .     

       ,  
      . 

         
        . 

   

 NGC       
 .          
         . 

        
  .      , 

 , S1,      .  
, S2,    8   S1.     

     (  )   
 S1       S2 (  15 ). 

:  8  S2     (  
 S1,      )    

   ,       
  . 



 

      |   51 

  

         
BioFrac™,        . 

         . 
    .  

 ,        .  
 ,       .   

      .   
        

 BioFrac. 

:    (Manual) (   System Control   ChromLab)  
         Fraction 

Collector.           
     . 

 



2   |    NGC  

52   |     NGC™    ChromLab  

  

■    – 500 ./ . . 

   
 

 

 

 
 

  

  

       
 

  

1 ■        (    
  ) 

■    (       
 ) 

2-12   

In        pH 



 

      |   53 

       (01  02) 
 

   

1 1 ■        (  
    ) 

■    (      
  ) 

1 2-11 

12 

   

    2 

1 In       
 pH 

2 1-12    

2 In   1 

    

     . 

■     ,     
 . 

■     ,       
. 

■         
  Point-to-Plumb™. 

■   Inlet    . 

■     ,     
 . 

■     ,     2: 

□     Inlet. 

□   12  1. 

□        2. 



2   |    NGC  

54   |     NGC™    ChromLab  

    

 NGC       
.         

. 

     ( 1)      
 ,   pH.  1  1 

           
.       12  1   

     ( 2). 

    ,      11 
.     ,     

 22 .  1     10 ,  2 –  
12 . 

:           
    –   .    
   ChromLab    ,    

«     /   »  
     NGC   

 ChromLab. 



 

      |   55 

  к  

 NGC      .  
         

,     15 .    
        

      .    
 ,         

 ( ,     ).    
  ,      

  ,       
.       . 

         ,   
     .   ChromLab   

     . 
    . 

       .  
ChromLab          

.        .  
      ,  NGC 

      .  
  ,      

  . 

 



2   |    NGC  

56   |     NGC™    ChromLab  

 

  

■   : 3 650 / . . 

■           
 

■   

■    



 

      |   57 

    
 

 

 

 

 
 

 

  
 

    

 
 

  

 

 

  

Top 1-5        

Bottom 1-5        

In          
 

Out         -  



2   |    NGC  

58   |     NGC™    ChromLab  

    к  

      . 

■     ,     
    . 

■    ,      
   . 

■     ,       
   . 

■    ,        
  . 

■         
  Point-to-Plumb™. 

     

 NGC      .  
         
.          

  Top.         
   Bottom.     

. 

  (    )       
.   Reverse Flow   ChromLab     . 

      ,    
 .      ,  

     , ,   
      .    

,       . 

       : 

■ ; 

■  ; 

■  . 



 

      |   59 

  «      »  
    . 

      ,    
 .      ,  

   (   ).     
          . 

  Manual  Method        
,         , 

         
. 

      

          
       ChromLab. 

        

1.          
          . 

2.    Column Switching Valve (   ), 
 ,          
  . 

 



2   |    NGC  

60   |     NGC™    ChromLab  

■  Bypass ( )       . 

 

■  Reverse Flow Direction (     
)        . 

 



 

      |   61 

 

         . 
   ,     

      (   ).  
,    ,     NGC. 

       (A  B),  
  ,      : 

1.    ; 

2.     ; 

3.     ; 

4.    . 

 



2   |    NGC  

62   |     NGC™    ChromLab  

          
.    ,    
,   .     

     ChromLab     
    NGC      

 ,          
.      «  F10»  . 30  

«  F100»  . 30. 

  

  

1    2   

3     B 4   

5     A 6    



 

      |   63 

  

     ,     ,  
  .       

         
 . Bio-Rad       

  .   2  3    
         

    .        
«   »  . 186. 

:        . 

 2.        F10 
 

  
 

   ( / ) 

     
  ( ) 

   
    

263  ( ) 0,01-1,00 0,1-1,99 

750   1,00-9,99 2,00-5,99 

2  10,00-20,00 6,00-11,99 

5    12,00-20,00 

 3.        F100 
 

  
 

   ( / ) 

     
  ( ) 

    
   

750  ( ) 1,00-4,99 <5,00 

2  5,00-14,99 5,00-11,99 

5  15,00-39,99 12,00-39,99 

12  40,00-100,00 40,00-80,00 



2   |    NGC  

64   |     NGC™    ChromLab  

   

     . 

■    ,      
 A. 

■    ,      
 B. 

■   ,    . 

■         
  Point-to-Plumb™. 

 

    NGC   ,   
     - ,  

  ,   -    
.   -     

        
   .    

  .         
,     . 

-     

-        
      .  

    (  ) . 



 

      |   65 

 -     

 

 -     

 



2   |    NGC  

66   |     NGC™    ChromLab  

 -  

  

  

1   2   

3   -  4  -  

5  Point-to-Plumb™   

  

■     -  

■   :  5000  

:      0,9 , , 
  ,     . 

        «  
   - »  . 201. 



 

      |   67 

■    -        

□ 255  

□ 280  (  ) 

:       ChromLab.  
       

   NGC    
ChromLab. 

■    - : 0-3000 . . . 

■  : ±5% 

■         2 , 
5  (  )  10 .      

 4  . 69. 

:     2   
   .    

   5   10  ,     
    . 

        «  
  - »  . 196. 



2   |    NGC  

68   |     NGC™    ChromLab  

   

  

  

1   2   
  

3      

  

■       . 

■   :  2000   
   . 

        «   
  »  . 209. 

:         
   Multi-Wave Detector (  )  

      . 



 

      |   69 

■         -  
   190-800 . 

:       ChromLab.  
       

   NGC    
ChromLab. 

■    - : 0-3000 . . . 

■  : ±5%. 

■         2 , 
5  (  )  10 .      

 4. 

        «  
  - »  . 196. 

:     2   
   .    

   5   10  ,     
    . 

 4.      -  
 

  2  5  10  

F10 500 ./ . .    

F100 500 ./ . .    

  

  

■   : 0,01-999,9 /  

■   : 0,01-300 /  

■ : ±2% 

■   : 6  

■     : 4-100°C 



2   |    NGC  

70   |     NGC™    ChromLab  

   

-  

 ChromLab     ( . .   
- ,    ).  

     NGC.      
    . 

       . 
         

 60-90 . 

:       
       60 . 

  

      
    ,     . 

   ,    . 

        ,  
      

 ,    .  
        

        
     (  

  ChromLab). 



 

      |   71 

  

 

          
         

   -      . 
(  NGC      20 ./ . .). 

     70 ./ . .  pH  
Bio-Rad       

    pH. 

: Bio-Rad      
         72 ./ . . 

(0,5 ). 



2   |    NGC  

72   |     NGC™    ChromLab  

 pH 

 pH    ,    
- .   ,   - , 

    .     ,  
          

 /     ( ,   
).  p        

. 

  pH    

■ pH (   pH) —     pH,  

■ Bypass (  ) –   pH-  

:    pH-  . 

 



 

      |   73 

  

■   : 90  (200 ,    ) 

■    : 70 / . . 

■   pH: 0-14 

■ : 0,1 . pH  2-12 

■ : 80-120% 

■ : ±60  

:       -    
    7.     pH    

«   pH»  . 218. 

  pH 
 

 

 

 
 

 pH 

  pH 

 
 



2   |    NGC  

74   |     NGC™    ChromLab  

  

In     

Out     

Cal In       
  pH 

Cal Out      

   pH 

 -         
 .  ChromLab       

 . 

         ChromLab  
   -     - .   

       «   
    pH»  . 75. 

  pH        

  pH        . 

    ChromLab    
.       «  pH» 

 . 145. 



 

      |   75 

      pH 

          
 pH       ChromLab. 

       pH 

1.          pH  
        . 

 

2.    pH Valve (   pH)   
: 

■ pH (   pH) —     pH 

■ Bypass (  ) –    pH 



2   |    NGC  

76   |     NGC™    ChromLab  

, ,    

    ,     
 NGC. 

 

 5.     NGC 
 

   
 

 
  

  
 

 

 PEEK,  . .: 
1/16" 

. .: 
0,020" 

  
, 

 
   

 40 /  

7 000 / . .  

 PEEK,   . .: 
1/16" 

. .: 
0,030" 

  
 

7 000 / . .  

  
 

( ),  

. .: 
1/8" 

. .: 
0,062" 

  500 / . .  

 Tefzel, 
 

. .: 
1/16" 

. .: 
0,020" 

  4 000 / . .  



, ,    

      |   77 

  

 6.      NGC  
 

  
 

    
 

100     4 000 / . . 

250     4 000 / . . 

500     4 000 / . . 

1     3 000 / . . 

2     3 000 / . . 

5     3 000 / . . 

DynaLoop™ 25: 
25  

   
 

1 000 / . . 

DynaLoop 90: 

90  

   
 

1 000 / . . 

 

  NGC     
 .  ChromLab    

       (Method 

Editor) 



2   |    NGC  

78   |     NGC™    ChromLab  

 

  NGC    10/32  1/4-28, 

       
 . 

 7.     
 

   

   GE Healthcare M6 
( .,   XK, C, SR,  

 , HiTrap, HiPrep, HiLoad) 

 Tezfel 1/4–28  .  
 M6  .  (Bio-Rad 750-

0561); 

1    1  

     
  Bio-Rad ( .,  

 Econo-Column® , Econo-Pac®, 
  Econo-Pac, Bio-Scale™ 

Mini) 

   
  .   M6  

.  (Bio-Rad 732-0111); 

1    1  

:         
.  Bio-Rad № 5326,    

 . 



     

      |   79 

     

  NGC   ( ),    
            

(  -    ).    ,  
 : 

■      (   ) 

■       (   ) 

■   ,     Point-to-Plumb 

(    ) 

   NGC    , 
   . 

 

 

 

 

 
 

 

  
 

 
 

  

 

 ,   NGC        , 
   ,    ,  

  ,    ,   
   .       

  OK   ,    
    ,       

 ,   . 



2   |    NGC  

80   |     NGC™    ChromLab  

 

  

  NGC      
 ,       .  

      ,  
    ,    

    .    , 

    ,     
  ChromLab.      , 

   , ,   
: 

■         
    1/8"      

 . 

■        PEEK   
 1/16". 

    ,   . 
          

 .        
 ,    .   

       . 

          
 .        

         .  
         

      . 



 

      |   81 

 

       .  ChromLab 
       .   

     ,     
  Bio-Rad,      

 . 

    : 

■      

■     A 

■     B 

■       , : 
 

□   

□     



2   |    NGC  

82   |     NGC™    ChromLab  

    

      : 

■   ,   . 

■        . 

    .    
   «    »  . 118. 

        

          
          

     .  8   
         . 

 8.      
 

    
 

  . . 1/8"  
 -

 (    
 ) 

1 /  15-25  ≥6" 

5 /  50-100  ≥6" 

10 /  200  ≥6" 

100 /  1,05-1,4  ≥42" 



 

      |   83 

  

 NGC       : 

■    –    . 

■        –    
 . 

          
.         

   .      
       .   

  (Delta P)   ,   
  ,    . 

■      –      
. 

     ±2%  2 ./ . .,    
,   . 

  

 NGC    ,   
   ,    

  .       
  . 



2   |    NGC  

84   |     NGC™    ChromLab  

  NGC 

   NGC     
  NGC  ,     

ChromLab.         
    ,      

   ,        
   . 

       . 
          

 ,     .   
          

 NGC. 

        .  
      .   

            
        

. 

         
«    »  . 238. 

 



   

      |   85 

   

  ,     ,    
  . 

 

: ,      ,   
    . 



2   |    NGC  

86   |     NGC™    ChromLab  

  NGC 

  NGC     . 
    ,    .  

        
.       

   . 

:   NGC      10 /   
100 / . 

 9.    NGC  
 

 NGC Quest NGC Scout NGC Discover NGC Discover Pro 

      

 -  
  

 

(    NGC 
Quest  NGC Scout) 

    

 
  

  
 

(     
NGC) 

  * * 

  A  B     

     

  pH     

   
  

    

  
к  1 

    

       

  
  A  B 

    

  
 

    



  NGC 

      |   87 

 9.    NGC ( ) 
 NGC Quest NGC Scout NGC Discover NGC Discover Pro 

 
  

    

   1     

  1     

*   NGC Discover     . 



2   |    NGC  

88   |     NGC™    ChromLab  

 



 

      |   89 

 3   

 NGC™      
,    .   

         
 .        

NGC      . 



3   |     

90   |     NGC™    ChromLab  

  

 NGC       .  
  NGC     . 

:   ,     
   «       NGC»  

. 227. 

   NGC 

   NGC    
 .  9  . 86     
. 

:         
    .     

        . 

  NGC Quest™ 

 

  NGC Scout™ 

 



  

      |   91 

  NGC Discover™ 

 

  NGC Discover Pro 

 



3   |     

92   |     NGC™    ChromLab  

     NGC 

  NGC    .  
     .  

       . 

   ,   ,   
   .   : 

■   NGC 

■  1  

■     

■     

■      

■      

■       (2) 

■       

■  1/4-28 

■     (2) 

■   1  

■   (2) 

■  

■   20 ./ . . 

■   ,  (1,   PEEK) 

■   ,  (2,   PEEK) 

■  (2)     (       
        - ) 

■  №2 (       
  20 ./ . .) 

■  №4 (       BioFrac™) 



     NGC  

      |   93 

   NGC Scout 

   NGC Scout   ,      
 NGC,  : 

■  №2 (    20 ./ . .    
 pH) 

■      pH 

■         pH 

■         

   NGC Discover 

   NGC Discover   ,     
  NGC Scout,  : 

■         (2) 

■         

■  1/4-28 

■      

■     (14)    

■  (10)     (     (  
)            

  (  )) 

   NGC Discover Pro 

   NGC Discover Pro   ,    
   NGC Discover,  : 

■    (8)    

■  №6    

■     (12) 

■  №10    



3   |     

94   |     NGC™    ChromLab  

       
 

          
. 

   

             
     .      . 

 

    

            
. ,         

 ,       .   
   . 

:        . 



   

      |   95 

   

  NGC      
 ,     .  

     6  . 77. 

:    ,    «   
   NGC»    

  NGC    ChromLab, , 
   . 

      

►       Loop E,    –   Loop F 
  . 

       Loop F,     , 
       Loop E  . 

 

       Loop E      
  Loop F. 

 



3   |     

96   |     NGC™    ChromLab  

      

  NGC     ,   
 W1  W2  .  ,    

     .   
         

 .     ,  
 . 

:     ,    
,   . 

       

1.             
. 

 

2.   (  )   W1  W2  
. 

3.       W1   –   W2. , 
         

( ,  ). 



  

      |   97 

 

4.     . 

  

 NGC       
      .   

  . 

  pH (  )     -

.      pH    
«   pH»  . 218. 

-  

-     .    
 . 



3   |     

98   |     NGC™    ChromLab  

   

        -  
 . ,        

 . Bio-Rad       
  . 

 F10     263 ,     
.         
          750  

 2 .  F100     750 ,   
  .          

       2 , 5   12 . 

  10        
         

(  ). 

  11  . 99       
         . 

:        . 

 10.      NGC  
     (  ) 

 

    ( / ) 
  F10  F100 

263  

(   ) 
0,1-1,00   

750  

(   ) 
1,00-9,99 1,00-4,99 

2  10,00-20,00 5,00-14,99 

5    15,00-39,99 

12    40,00-200,00 



   

      |   99 

 11.      NGC  
      

 

    ( / ) 
  F10  F100 

263  

(   ) 
0,1-1,99   

750  

(   ) 
2,00-5,99 <5,00 

2  6,00-11,99 5,00-11,99 

5  12,00-20,00 12,00-39,99 

12    40,00-80,00 

      

►          
 «   »  . 186. 



3   |     

100   |     NGC™    ChromLab  

    

     ChromLab™  
      .  
           

 NGC.       . 

     ,   
. 

■         
     1/8"  
     . 

■        PEEK 

  1/16"       
,     . 

:          
  . 

       .  ChromLab 

       .   
     ,     

 ,       
. 

 

 

!   ,     , 
       . ,  

        
 ,        

   . 



    

      |   101 

       
 

          
          

     .  12   
         . 

 12.      
 

   
 
 

  . . 1/8"  
 -

 (    
 ) 

1 /  15-25  ≥6" 

5 /  50-100  ≥6" 

10 /  200  ≥6" 

100 /  1,05-1,4  ≥42" 



3   |     

102   |     NGC™    ChromLab  

     

          
 .        

  . 

: Bio-Rad        
. 

        

1.     Shut Down ( )   
     ChromLab    NGC. 

2.        . 

 

3.             
      NGC. 

4.        : 

.            
 . 

.            
   . 



    

      |   103 

5.       : 

.            
         

. 

.            
   . 

6.          
: 

.             
   . 

.            
      . 

          A 

 B           
 .          

   A  B, .     
     ,     

 ,    ,     
. 

    

1.   NGC. 

         
. 

2.  File > System Settings     System Settings. 

3.   Air Sensors (  ). 

      ,  . 
  . 

4.          
-        Sample ( ) 

(    ),  Buffer ( ) (   
 ). 

5.    OK. 



3   |     

104   |     NGC™    ChromLab  

     NGC 

:       C-96    
   NGC,    . 

          
(SIM)   NGC,         SIM. 

■     C-96   SIM   
 D «   C-96   NGC»  . 289. 

■     SIM   NGC    
«   SIM   NGC»  . 105. 

■        SIM   
 «      SIM»  . 107.  

   «   »  
     NGC  
  ChromLab      

 . 

■          
   . 

-    
 

         
      SIM.  -

   ( ),  NGC   
      DIGITAL IN  SIM  
       DIGITAL OUT. 

,     C-96   SIM,  
 NGC      

 .     DIGITAL OUT  DIGITAL IN 

 SIM   NGC    ,  
        . 



     NGC  

      |   105 

     NGC 

     ( )     
        NGC   
  (SIM).  SIM      

        SIM 1 

 SIM 2.     (    System Settings 

(  )   ChromLab),     
  ,    ,  

      Evaluation ( ). 

Э      NGC 

     NGC     
 SIM       ,  

  .  SIM     
   NGC      -

  ( ).       
 2  DIGITAL OUT  SIM     

,     .    2 
   (High (5 ))   (Low (0 ))    

         . 

    (    System Settings   
ChromLab)        

. 

  SIM   NGC 

   SIM   NGC 

1.      ,   
 SIM. 

2.          
   SIM. 



3   |     

106   |     NGC™    ChromLab  

 

3.           
      NGC. 

 

    

 

 

  
 

 
 

USB-   



     NGC  

      |   107 

     SIM 
 

 

!       . 
    ,      

   . 

         
  SIM.      ,    

 ,     SIM. ,   
   . 

■       NGC   
    SIM 1,    SIM 2. .   «  

     SIM 1  SIM 2». 

■       NGC   
   A  . ,    
    NGC     
    DIGITAL OUT. .  «   

    A  DIGITAL OUT  "  . 112. 

:  SIM     . 

      SIM 1  SIM 2 

1.     SIM    SIM 1  SIM 2 

    . 

 

2.   ,      
SIM. 



3   |     

108   |     NGC™    ChromLab  

3.       . 

:    ,  .   
  . 

 

 

 

 

  (+)   
( ) 

  (-)  

4.      ,   
. 

5.      ,  ,  
  . 

 :       . 

6.    . 

7.      20-24 AWG. 

8.   U-         
. 

 



     NGC  

      |   109 

9.         
   . 

 

10.          . 

:   . 
 

 

 

 

  (+)   ( ) 

  (-)  



3   |     

110   |     NGC™    ChromLab  

11.          
   . 

 

12.        (  ) 
   . 

 



     NGC  

      |   111 

13.     SIM 1  SIM 2     SIM. 

 

14.    «   »  
     NGC  
  ChromLab      

    . 



3   |     

112   |     NGC™    ChromLab  

      A  DIGITAL OUT   

1.     SIM   A     . 

:  ChromLab     .  
     SIM     

(DAC A). 

 

2. ( )   ,   NGC   
 ,   DIGITAL OUT   

 . 

3.   ,      
SIM. 

4.   (+)     DAC A,     
2  DIGITAL OUT. 

:  1  DIGITAL OUT   
.        1.  2 – 

   . 

5.     ,    . 

6.      ,  ,  
   . 

:       . 

7.    . 

8.   ,      
 . 



     NGC  

      |   113 

9.         
  DAC A   ,    . 

10.       2  DIGITAL OUT  
 ,   ,    . 

 

11.          SIM. 

12.    «   »  
     NGC  

  ChromLab      
    . 

 

 
 

 
 

   



3   |     

114   |     NGC™    ChromLab  

  NGC 
 

 

!  NGC    .   
,     . 

   NGC 

►          
 NGC. 

 

    

 

 

  
 

 
 

USB-   

:         
 . 



  NGC  

      |   115 

  NGC   
 ChromLab 

:       ChromLab  
      NGC   

 ChromLab. 

   NGC    ChromLab 

►       ,   
  ChromLab (   ChromLab): 

■     ChromLab   . 

■  ChromLab   . 

       
  NGC. 

:       File > Connect to system. 

   System Connection (  )   
   Connect ( ). 



3   |     

116   |     NGC™    ChromLab  

      
Point-to-Plumb 

 Point-to-Plumb   ChromLab   
       

     . 

   Point-to-Plumb       
 Tools  System Control  ChromLab. 

   Point-to-Plumb       
 Point-to-Plumb,      . 

 

     .   
   -  ,      

. 



      Point-to-Plumb 

      |   117 

     

1.      Point-to-Plumb    ,  
         

. 

    . 

 

           
  . 

2. ,     ,   
,       Point-to-Plumb. 

     . 

3.      , ,   
       . 

4.        Exit Point-to-Plumb 

( ). 

       (  )  
   . 



3   |     

118   |     NGC™    ChromLab  

    

          
           

 . 

: ,        
  .       

«        NGC»  . 
265. 

        NGC. 

 13  ,     . 
      . 

 13.         
 NGC 

 

NGC Quest NGC Scout NGC Discover 

   
  

  A. 

   
 Q1-Q4 

  
  . 

:   
  A  B 
  , 

  
   

 . 

   
 Q1-Q4 

   
 . 

:   
  A  B 
  ,  

  
   

. 

   
  

  B. 

    
  A  B. 

     
  . 



    

      |   119 

    NGC Quest 
 

 

!      ,   
     .   

            
 . 

    NGC Quest     ChromLab.  
      ChromLab   

 NGC. 

:       ,   
  .       

    Waste    . 

    

1.              
    ( , )   

 . 

2.   30        A. 

3.          
     . 

 

  

 

  
 
 

   
 

  
  

 
 

4.       ,     
   ( . 10 ),      . 

5.        ,   
. 



3   |     

120   |     NGC™    ChromLab  

6.         . 

7.   2-6    B. 

    

1.   ChromLab       ChromLab  
 . 

2.        NGC Quest,   
 NGC Quest Plus. 

3.          
      . 

 

4.      System Pump Waste 
(   – ). 

 



    

      |   121 

5.           
     . 

 

6.    System Pump (  ): 

.    (Flow Rate)  10 / . 

. ( )   (Duration)     
1 . 

.   Start. 

 



3   |     

122   |     NGC™    ChromLab  

    NGC Scout 

   NGC Scout       
     ,    Q4  

 Q1.        ;    
 .      

   ChromLab. 

:         NGC. 

  NGC Scout 

: ,     .   
 ,      , 
   «   NGC Scout»  . 124. 

       

1.     Q1–Q4     
. (      «   

    »  . 276). 

2.   ChromLab       ChromLab  
 . 

3.        NGC Scout,   
 NGC Scout Plus. 

4.           
     . 

 



    

      |   123 

5.    System Pump    Priming  
  Mode. 

:   Priming      
    (W2).     

          
. 

    .    Closed ( ). 

6.   Q4    . 

 

7.   30        A. 

8.          
     . 

9.       ,     
   ( . 10 ),      . 

10.        ,   
. 

11.         . 

12.   7-11   Q3-Q1. 

13.     B,   Q3    
 7-11. 



3   |     

124   |     NGC™    ChromLab  

  NGC Scout 

       

1.    System Pump    Priming  
  Mode. 

 

■         
   2. 

■         
    3  . 125. 

2.          
  : 

.  ,   . 

. ( )   ,   . 

      20 / . 

.   Start. 

.   2 -    . 



    

      |   125 

3.            
: 

.   All ( ). 

. ( )   ,   . 

      20 / . 

.   Start. 

         
    ,       

   ,      
Q1 - Q4.       

,         
    Q3      
 .       

   . 

:          
 Stop.      , ,   
        

  . 



3   |     

126   |     NGC™    ChromLab  

    NGC Discover 

   NGC Discover      
      ,   

 Q4   Q1,   –    , 
    A1.    NGC Discover 

           
   ,       

,      .    
     ChromLab. 

:         NGC. 

  NGC Discover      : 

■       

■      

■     

■     (  NGC Discover Pro) 

  NGC Discover 

: ,     .   
 ,      , 
   «   NGC Discover»  . 133. 

:       ,   
  .        

  ,       
    Waste    . 

       

1.     Q1–Q4     
. (       «  
    NGC Discover»  . 278). 

2.   ChromLab       ChromLab  
 . 

3.       NGC Discover. 



    

      |   127 

4.           
     . 

 

5.    System Pump    Priming  
  Mode. 

:   Priming      
    (W2).     

          
. 

6.   Q4    . 



3   |     

128   |     NGC™    ChromLab  

 

7.   30        A. 

8.          
     . 

9.       ,     
   ( . 10 ),      . 

10.        ,   
. 

11.         . 

12.   7-11   Q3-Q1. 

13.     B,   Q3    
 7-11. 



    

      |   129 

      

1.         . 

2.   ChromLab       ChromLab  
 . 

3.    System Pump      
, , Buffer A1. 

 

4.   30        A. 

5.          
     . 

6.       ,     
   ( . 10 ),      . 

7.        ,   
. 



3   |     

130   |     NGC™    ChromLab  

8.         . 

9.   4-8       
. 

10.     B  Buffer B1    3-9 

   B. 

     

1.         . 

2.   30     . 

3.          
     . 

 

 

 

 
 
 

  
 

 
  

 
 

4.       ,     
   ( . 10 ),      . 

5.        ,   
. 

6.         . 



    

      |   131 

     (  ) 

1.        . 

2.   ChromLab       ChromLab  
 . 

3.            
         . 

 

4.            
. 

 



3   |     

132   |     NGC™    ChromLab  

5.   30        . 

6.       ,     
   ( . 10 ). 

7.         . 

8.   4-7      . 



    

      |   133 

  NGC Discover 

       

1.    System Pump    Priming  
  Mode. 

:   Priming      
    (W2).     

          
. 

 

■         
   2  . 134. 

■         
    3  . 134. 



3   |     

134   |     NGC™    ChromLab  

2.          
  : 

.    . 

. ( )   ,   . 

      20 / . 

.   Start. 

.   2 -    . 

3.            
: 

.  All ( ). 

. ( )   ,   . 

      20 / . 

.   Start. 

         
    ,       

   ,      
Q1 - Q4.       

,         
    Q3      
 .       

   . 

:          
 Stop.      ,    

     . 



    

      |   135 

      

1.    System Pump    Priming  
  Mode. 

 :   Priming      
    (W2).     

          
. 

2.      , , Buffer A1. 

3. ( )   ,   . 

      10 / . 

4.   Start. 

 

5.   2-4       
. 



3   |     

136   |     NGC™    ChromLab  

     

1.            
     . 

 

2.    Sample Pump    (  Flow Rate) 
 10 / . 

 



    

      |   137 

3.   Change Position (  )   
    Sample Pump Waste   

 . 

 

4. ( )      Enable Air Sensor  
  Sample Pump       

. 

5.   Start. 

     (  ) 

1.            
         . 

 



3   |     

138   |     NGC™    ChromLab  

2.    Sample Pump     : 

■       ,  S1 Port 8  
      . 

■         Valve 2  
 S2 Port 8     . 

3.    (Flow Rate)  10 / . 

4.   Change Position (  )   
    Sample Pump Waste   

 . 

5. ( )      Enable Air Sensor  
  Sample Pump       

. 

 

6.   Start. 

7.      ,    
       . 



          

      |   139 

     
     

:         
            

   . 

           
,        

: 

■ 0,3 /       F10 

■ 3,0 /       F100 

       ,  
       

    .    
  ,        

 

■ 1,0 /         F10 

■ 10 /         F100 

:            
,    «    »  

. 118. 



3   |     

140   |     NGC™    ChromLab  

  

       . 
       -    

   (  ).     
    ,    . 

      ,      
    ,     

1–10 .        ,   
       ,  

   35   . 
 

 

!         
 NGC      ,   . 

,         . 
   ,   ,  

    . 



  

      |   141 

     NGC 

 NGC          
  ,       
.          .  

         35 . 

:         
 . 

  

 !   .    . 



3   |     

142   |     NGC™    ChromLab  

    

:    ,     
,    .  ,    

 «    »  . 118. 

     

1.           : 

■        

■         
(1-5) 

2.      . 

3.           : 

■ -  

■         
(1-5) 



  

      |   143 

  

      ChromLab.      
  ChromLab    NGC.   
          System 

Control  ChromLab.  ,        
  (Method Editor): System Preparation (  ), Column 

Activation (  )  Column Wash (  ).   
         
   NGC    

ChromLab. 
 

 

!        ,  
         

( ,      ). 

:        
.      ,    
  .     

      . 
         

  ,  ,   
     . 

   

1.        . 

2.           
     . 

3.    System Pump (  ): 

.   NGC Scout  NGC Discover    Mode 

    : 

■ Gradient via Inlet Valves (    ) 

■ Gradient via Blending Valve (     
  ) (  ) 

.    (  Flow Rate)  1 /  (   
   ). 

.    (Isocratic). 

.   (  Duration)  3-5  (   
   ). 



3   |     

144   |     NGC™    ChromLab  

.   Start. 

 

4.    3-5   (CV)   (   
   ). 

5.    3-5   (CV)  
  (      

). 

6.    3-5   (CV) , 
  (      

). 

7.    10   (CV)  
  (      

). 

8. ( )    20%  (     
 ). 



  NGC  

      |   145 

  NGC 

 NGC      .  
           

 .      
       

      .   
     . 

     NGC    
  .  ChromLab    

  ,    
  ,         

. 

:           
 . 

:        .  
     ChromLab    
        

NGC    ChromLab. 

  pH 

           
     .       

 . 

   pH 

1.     : 

■   ChromLab   System Control,   
Tools > Calibrate   pH   . 

■    NGC  Calibrate    
 ChromLab   pH   . 

 

2.  ,     pH Calibration. 

3. ,    Status ( ) (     
) – Calibrated ( ). 



3   |     

146   |     NGC™    ChromLab  

   

         
.     . 

:     ,   
   . 

    

1.     : 

■   ChromLab   System Control,   
Tools > Calibrate   Pump Flow Rate (  ) 
  . 

■    NGC  Calibrate    
 ChromLab   Pump Flow Rate   . 

 

2.  ,     Pump Flow Rate 

Calibration. 

3. ,    Status (     ) – 

Calibrated. 

 « »   

         
 : 

■    

■   

■   к  

    

1. ,         
 . 

2.     : 

■   ChromLab   System Control,   
Tools > Calibrate        . 

■    NGC  Calibrate    
 ChromLab        . 



  NGC  

      |   147 

3.  ,     Calibration. 

4. ,    Status (     ) – 

Calibrated. 

   

       
       

 . 

    

1.     : 

■   ChromLab   System Control,   
Tools > Calibrate   Conductivity Monitor (  

)   . 

■    NGC  Calibrate    
 ChromLab   Conductivity Monitor   . 

2.  ,     Conductivity Monitor. 

3. ,    Status (     ) – 

Calibrated. 



3   |     

148   |     NGC™    ChromLab  

 



 

      |   149 

 A   
 

     NGC™   
.        

     NGC. 
 

 

!       
 NGC.      NGC,    

      .   
     Bio-Rad. 



A   |      

150   |     NGC™    ChromLab  

    NGC 

           
       . 

□       .   
      ,   

    . 

□    .       
. 

    NGC 

:         System 

CIP/Storage (    /   )   ChromLab. 

         
     NGC   

 ChromLab. 

□        1 N 

NaOH. 

□        
  NaOH. 

□            
    NaOH. 



  NGC  

      |   151 

  NGC 

:         System 

CIP/Storage (    /   )   ChromLab. 

        
   NGC    

ChromLab. 

   NGC        
  : 

■         . 

■   NGC    ,     
 .      

  ,   . 

  ChromLab    ,   
      (    ). 

   NGC       
  : 

■        . 

■     ,    
System CIP-Storage   ChromLab ,     

 Bypass. 

■         
. 

■          
     . 

■           
       20% , 

  . 



A   |      

152   |     NGC™    ChromLab  

    

 14       
 NGC. 

 14.     NGC 

   

   

  pH   pH.   
ChromLab   Tools > Calibrate,  

  pH   . 
 pH-   ,   

   .  
     15. 

:      
. 217. 

   
 

    . 
       

     . 
        

    20% . 
:     –    

ChromLab. 

     
    

  NGC  
  ChromLab. 

     . 

 

   

        
   . 

         
   . 



    

      |   153 

 14.     NGC ( ) 
   

   

    
   
 

      
    

 . 
    

    
      

    
 . 

   
  

  . 

   ,  . 
      ,  . 
 pH-        

. 
      
.   ChromLab   

Tools > Calibrate,    pH  
 .   

,    . 
    pH. 
 pH-   ,   

   .  
     15. 

:      
. 217. 



A   |      

154   |     NGC™    ChromLab  

 14.     NGC ( ) 
 

   

     

        . 
     .   

ChromLab   Tools > Calibrate. 
  ,   
 . 

 pH-        
.   ChromLab   

Tools > Calibrate,    pH  
 .   

,    . 
    pH. 
  ,     

.    
 pH-    

 15. 

:      
. 217. 

   
  

    
 . 

      (  
)   . 

    
   
 

      
    

 . 
     . 
    

    
      

    
 . 

 -,   
 

 

    . 
    . 

  . 
   

 
 

  ,   
    . 



      

      |   155 

      

  15       , 

     NGC. 

 15.       NGC 
 

  

          
 

!       
    . 

. «     NGC»  
. 150. 

   1 N NaOH     
  

   20%   20%  

  .   

  NGC  20%   20%  

 pH-  ■    -   
    7 

■  4     1     
  pH 4 (1:1)  

   2  2%  Contrad ( . № 176-4118) 

  10 .     
 20% . 



A   |      

156   |     NGC™    ChromLab  

      

    NGC     

(     ).       
         . 

    NGC –   ,   
        

    . 

         . 
        

 ,        
. 

  NGC 

         NGC: 

■     

□    

□    ,    

□       

■      

□     

□         
 

□          
 

□        

□   

□  



      

      |   157 

    

  

  

1      2     

3    4      

5    6    



A   |      

158   |     NGC™    ChromLab  

     

  

  

1  2   

3  4     
 

5     6     
 

7    
  

8    (  
 ) 

9     
 

  



      

      |   159 

  

            
. 

    : 

■    

■     

■   

   
 

 

!         
  .     

          
    . 

    

1.     Shut Down     
   ChromLab    NGC. 

2.           
 . 

:        
  . 



A   |      

160   |     NGC™    ChromLab  

3.     3/16",    ,  
          

. 

  

 

!          
,  ,       

. 

4.       .    
   . 

 



      

      |   161 

5.          
.         , : 

■         

■       . 
 

 

 

 
 
  

6.           
, ,       . 

:         
. 

:          
.      . 

7. ( )         
. 

:        ,  
      . . «     

 »  . 162. 

8. ( )    .   
    «     

»  . 167. 



A   |      

162   |     NGC™    ChromLab  

9. ( )    . 

:        
.       «  

  »  . 169. 

    

1.           
   «      » 

 . 162. 

2.       . 

3.         
   5     . 

4.      . 

5.     . . «  »  . 175. 

6.        . 

7.     1 /     
  15 ,     . 

      

1.      ,    
 (OUT)  . 

 

:       (IN)    
    . 



      

      |   163 

2.           
   . 

 ,   ,      
 (IN)   .        

,     . 

3.     ,     (OUT) 

 . 

4.        (OUT)   
    . 

 ,   ,      
 (OUT)   .        

,     . 

5.   (IN)   (OUT)      
  . 

      

1.       ,   
. 

:    (IN)   (OUT)   
    . 

2.    .      
  . ,      
     . 



A   |      

164   |     NGC™    ChromLab  

3.        (IN)   , 
        (  

  (IN)  ). 

 

4.        (OUT)   
,         (  

  (OUT)  ). 

 



      

      |   165 

        

1.         , 
   ,        

. 

2.    (IN)        
        . 

 

3.      ,     
. 



A   |      

166   |     NGC™    ChromLab  

4.    (OUT)      
        . 

 



      

      |   167 

     

1.           
     . 

      .    
   . 

 

2.    . 

3.       . 

     ,    
.   ,  . 

4.         
. 

5.        ,   
   ,       , 

      . 



A   |      

168   |     NGC™    ChromLab  

6.        ,  
,        . 

 

  
   

 
 

 
 

 



      

      |   169 

    

     

1.  ,    «   » 
 . 159. 

2.           
 . 

3.          
.     . 

 

■      . 

■      . 

:    ,   « »  « »  
     . 

 

 
 
 
 
 

   
  
  

 

 
 

 

!   ,      
 . 

4.     .    . 

5. ( )         
 . 

:        ,  
      . . «      

   »  . 173. 

6.       . 



A   |      

170   |     NGC™    ChromLab  

  
 

 

!     .   
     . 

   

1.  ,    «   » 
 . 159  «    »  . 169. 

2.       ,    
   . 

       , 
,       ,   

  . 

3.     . 

.    ,    . 

.      . 

.          
,      . 

 

4.     .      , 
     . 



      

      |   171 

5.         
  ,    . 

      

      . 

 



A   |      

172   |     NGC™    ChromLab  

6.        . 

7.      ,      
   . 

 

 

 

 

  

  
  

        

1.           
     . 

      .    
   . 

2.    . 

3.       . 

     ,    
.   ,  . 

4.         
. 

5.        ,   
   ,       , 

      . 

6.        ,  
,        . 



      

      |   173 

      . 

1.       . 

■          
.     ,  

     .    
  (  ) . 

■     ,    
  .       

(  ) . 
 

 

 

 
 

 

 

 
 

 

 



A   |      

174   |     NGC™    ChromLab  

           
     .     

,    – .   ,    – . 

:        
 ,    «    

 »  . 169. 

2.            
  . 

:         . 

3.     . 
 

 

!         
,       . 

4.      : 

■        « ». 

■        . 
 

 

 

 

 
 

 

  
 

 

 
 

 

  
 

 

5.         (  
). 

6.         (  
). 

7.    . 

8.          . 



      

      |   175 

  

    : 

■   

■     

■    

  
 

 

!      . 
       . 

   

1.    ,       
   . 

       

2.     .     . 



A   |      

176   |     NGC™    ChromLab  

    

       : 

■         

■    
 

     

1.      ,    «  
     »  . 173. 

2.     ,   . ,  
     . 

3.       .    
  .     ,    – 

.   ,    – . 

:        
 ,    «    

 »  . 169. 

 

  
 

  
 

 

  



      

      |   177 

4.    ,    ,   
   . 

 

5.    ,    ,   
   . 

6.           
 . 

7.         . 

8.         . 

9.         
.  



A   |      

178   |     NGC™    ChromLab  

   

:     ,    
     ( . .    F10,    

F100).    . 

    

1.       ,    
   . 

      «    
  »  . 162. 

2.      . 

3.           . 

4.        . 
 

 

 

  

 
 

5. ,        
 . 



      

      |   179 

6.    .       
  ,     OUT  . 

■       . 

■       . 

  

 

!       .   
     ,     . 

7.         ,   
      . 



A   |      

180   |     NGC™    ChromLab  

8.    ,       . 

 

9.          
( ),      . 

10.       ,     
  . 

11.  . . «       
  »  . 267  «     
»  . 268. 



      

      |   181 

     

      .   
          

. 

      

1.         
(  OUT). 

 

 

 

  
  

 



A   |      

182   |     NGC™    ChromLab  

2.         . 

 

3.       . 

4.   .      
  . ,      

      ( ). 



      

      |   183 

5.  ,         
 . 

 

:      ,  
    . 

 



A   |      

184   |     NGC™    ChromLab  

6.          
      . 

 



      

      |   185 

   

     .   
         

  .       . 

:        
.        . 

       
«  »    . 

   

1.      ,  
  50:50  (  )     30  

          16 
     . 

 16.         
  

 

     

10 /  2 000 / . . 2 /  

100 /  1 000 / . . 2 /  

2.  30-       15   
         17 

. 

 17.         
  

 

     

10 /  3 250 / . . 4 /  

100 /  1 300 / . . 5 /  



A   |      

186   |     NGC™    ChromLab  

 

   

    NGC     
    .  

     2  . 63. 

    : 

■    

■   

■   

■  

■   ( ) 

■   



 

      |   187 

 

 

   

  

  
  

 
  

  

  

  
  

  

 

 



A   |      

188   |     NGC™    ChromLab  

  

        . 

:       NGC   
. ,    ,      

. 

   

1.     Shut Down     
   ChromLab    NGC. 

2.    ,     . 

 



 

      |   189 

3.        1/8   
  ,     . 

 

4.         . 

5.           
     . 

 

 
   

 
 

   
 



A   |      

190   |     NGC™    ChromLab  

6.         
  (  ). 

 

 

   

 
 

 

  



 

      |   191 

    

1.         
   (  ). 

 

 
  

 
 

 
 

 
 

  
 
 

 
 

 

2.      . 

3.     . 

 

:     ,  
  .     

,   . 

 

   
    



A   |      

192   |     NGC™    ChromLab  

      

:          
          
. 

1.    . 

2. ,         
,      . 

3.        
       

  . 

 

: ,         
    . 



 

      |   193 

    

1.       . 

2.            
 15   : 

 

■    

■   

■   

:   .   ,  
          . 



A   |      

194   |     NGC™    ChromLab  

  

:     ,      
     . ,   

     . 

   

1.       . 

: ,          
         

 . 

2.            
 . 

 



 

      |   195 

3.      .   -

 (   1,   2,  3   4). 
 

  1  2  

 

 

 4 

 3 

4.            
  . 

5.    , ,    ,  
,    . 

6.   NGC. 



A   |      

196   |     NGC™    ChromLab  

 

   -  

 NGC       5 . 
      (10 )  
 (2 )  .     

       .  
    -    

 . 

     

1.     Shut Down     
   ChromLab    NGC. 

2.        . 

3.            
. 

   -  
 

 

 

 1 

 2 



 

      |   197 

     
 

 

 

 1 

 2 

4.           . 

   -  

 



A   |      

198   |     NGC™    ChromLab  

     

 

5. ,        . 

 :      ,   .  
      .    
     . 

6.           
    . 



 

      |   199 

7.   ,   .   
 : 

■   

■     
 

 

 

 2 

 1  

 
 
 

 

 
 

  

8.      - . 

: ,        
 ,          . 

        
   .  



A   |      

200   |     NGC™    ChromLab  

 

   
  
,  
 

 

 

 

  

 
 1 

   
 2 

 
  1 

  
 2 

   

 

 

 

  
 

 1 

  
 2 

  
 

 2 
 

  
 1 

9.  .    . 

10.   1/4-28          
,    . 

11.     . 

12.   NGC. 



 

      |   201 

     
-  

         
 - . 

 

 

!        
 .      ,   

      . 

     -  

1.     Shut Down     
   ChromLab    NGC. 

2.          . 

3.     . 

4.     .      
 . 



A   |      

202   |     NGC™    ChromLab  

 



 

      |   203 

:    .       . 

 

 

  
 

 

  



A   |      

204   |     NGC™    ChromLab  

       .  
      . 

 

5.     . 
 

 

 
 

  
  



 

      |   205 

6.   ,          
  ,      . 

:          
 . 

 

7.   ,          . 
 

 

!      
.     . 

 

1.  
  

   

2.   
    
 



A   |      

206   |     NGC™    ChromLab  

 

        . 

 

8.        
 . 

9.          
. 



 

      |   207 

     

 

 

  

  

     

 

  

10.           
    . 

11.        . 

12.         . 

13.          . 

14.     . 

15.   NGC. 



A   |      

208   |     NGC™    ChromLab  

    

          Detector 

( )   System Information (   )  
ChromLab.          

   . 

     

1.   ChromLab. 

2.     : 
 

■   ChromLab   System Control  File > 

System Information    Detector. 

■       System Information  
    Detector. 

3.   Reset Lamp Time (    ). 

      -     0.0 . 



 

      |   209 

    
 

         
   .     
  ,    .   . 

 

 

!        
.      ,       
  . 

      

1.     Shut Down     
   ChromLab    NGC. 

2.          . 

3.     . 

4.       . 

       «   
    NGC»  . 227. 

5.  ,         
. 

 



A   |      

210   |     NGC™    ChromLab  

   ,    . 

 

:         
     .  

 

 
 

 
 

  
  

  
  



 

      |   211 

6.  : 
 

 

!     
 .       . 

.     . 

 

.      . 
 

 

 

 
 

 



A   |      

212   |     NGC™    ChromLab  

.     2,5       

  . 

 

.       . 

        
. 

 

.       
  . 

7.         . 

8.       . 

9.            
 . 

10.     2,5       
. 



 

      |   213 

11.      . 

:       , 
 - . 

 

12.        . 

13.       
      ,   . 

14.          . 

15.     . 

16.   NGC. 

:      
    . 

 

5-  
 

 
 

7-  
  

 



A   |      

214   |     NGC™    ChromLab  

   

        
  - .    

     ,    
  . 

    

1.     Shut Down     
   ChromLab    NGC. 

2.     . 

3.        . 

 



 

      |   215 

4.   ,      . 

 

5.        
. 

6.         . 

7.            
 –    . 

:      .    
    . 

 

 

 

!   ,      
  . 

 

  
 

  
  

 
 



A   |      

216   |     NGC™    ChromLab  

8.    ,        
. 

9.        . 

10.     . 

11.   NGC. 

:       
 . 



 pH  

      |   217 

 pH 

 pH-  

 pH-   ,      . 
       15  . 155. 

:    pH   Bypass.   pH-

   . 

  pH-  

1.   ChromLab. 

2.  Tools > Calibrate     Calibration. 

3.  pH    Calibrate. 

4.  Start    pH   . 

5.    pH   10    
 pH-       (Cal In). 

6.   Close     Calibration. 

:      ChromLab, 
    .   

 .    , 
    pH, . 

 pH-  

    

►        1   
: 

■ 0,1 M HCI 

■  H2O 

■ 0,1 M NaOH 

■  H2O 

■ 0,1 M HCI 



A   |      

218   |     NGC™    ChromLab  

     

►         
, : 

■   Bio-Rad, . № 161 -0722 

■ 2%  Contrad, . № 176-4118 

  pH 

  pH          
. 

   pH 

1.     Shut Down     
   ChromLab    NGC. 

2.     DNS      DNS   
  . 

 

 

 

 DNS 

  
 DNS 

 
 pH 



 pH  

      |   219 

3.      pH. 

4.    ,       . 

       
. 

5.     (2 )   . 

6.           . 

7. ,       . 

8.  ,  ,       
  . 

:     ,   ,   
  ,     . 

9.     pH    ,  
      . 

 

 

!       
,     . 

10.         pH. 

11.     pH    pH      
 . 

 

 !   .   pH  . 

12.       DNS     
. 

13.   NGC. 

14.   pH.      
 «   pH»  . 145. 



A   |      

220   |     NGC™    ChromLab  

  

     NGC 
 

 

!      
 NGC   .      

NGC,          .  
       Bio-Rad. 

         
 NGC.     NGC      

     . 

:         
    .       

 .     
,    NGC   . 

      NGC 

1.     Shut Down     
   ChromLab    NGC. 

2.             
  . 

3.    NGC      . 



  

      |   221 

 

:       . 

4.  ,      
 52" (1,32 ). 

: ,      ,   
.   ,   

 .       
      . 

■          
25" (63,5 ) – 100-24878. 

■          
52" (1,32 ) – 100-24892. 

5.      . 

6.       . 

:   ,       
        

  ,      
 .      . 



A   |      

222   |     NGC™    ChromLab  

 

 

 
  

  
  

7.   ,    . 

8.   .     . 
   ,     
.  

■ ,     ,   
   . 

■ ,     ,   
   . 



  

      |   223 

 

 

 

   , 
 ,   

    

    , 
 ,   

    

: 

 
 

  

 
 

  



A   |      

224   |     NGC™    ChromLab  

9.          
   . 

 

:       . 

 



  

      |   225 

10.        . 

 

11.         NGC     
   . 

12.        . 



A   |      

226   |     NGC™    ChromLab  

13.   : 
 

: . : 

     «       
NGC»  . 227 

  «   NGC»  . 264 

  «   NGC»  . 114 

  «    »  . 118 

  «   NGC»  . 145 



  

      |   227 

      NGC 
 

 

!    NGC  , 
   .    
  NGC,         

 .      
  Bio-Rad. 

  

 

!         
     -  NGC ( . № 788-4005). 

 NGC        . 

       NGC 

1.     Shut Down     
   ChromLab    NGC. 

2.       ,   
   . 

3.        . 

4.         ,   . 



A   |      

228   |     NGC™    ChromLab  

    . 

 

5.          . 

:       Bio-Rad,    
     Bio-Rad. 

6. ( )      . 

. «       »  
. 231. 

7.  ,    ,     
 . 



  

      |   229 

8.          .     
     . 

      . 

 

9.            
. 

:        
,       
. 

10. ,          
. 

11.  ,   ,  . 

12.       . 

 

      

    
  

 
   

  
 

  
    

 

    
  



A   |      

230   |     NGC™    ChromLab  

13.   : 
 

: . : 
  «   NGC»  . 264 

  «   NGC»  . 114 

  «    »  . 118 

  «   NGC»  . 145 



  

      |   231 

       

      ,      
    (  ,      
  ,   -   ).   

     ,     
. 

       . 

 



A   |      

232   |     NGC™    ChromLab  

      

1.   1-5  «       
 NGC». 

2.           
   . 

 

3.         . 

4.   7-12  «       
 NGC». 

 

    
 

  
 

  
    



  

      |   233 

      

1.  . 

2.   1-5  «       
 NGC»  . 227. 

3.       . 

4.         . 

5.   7-12  «       
 NGC». 



A   |      

234   |     NGC™    ChromLab  

  

:      .   
   ,    . 

   

1.         
 . 

2.         .  
   . 

 

3.         
  . 

    .     ,  
 . 

 

  
  

  

  
  

 

,   ( )    ,   –  
. 

 

  
 

    



  

      |   235 

4.    ,       . 
 

  

 
 

 
 

:         
 ,    . 

5.      . 

6.      (    

)       . 

.          . 

.      . 

 

.    ,      
        

. 

7.   ,     . 

 



A   |      

236   |     NGC™    ChromLab  

   

 NGC      20 ./ . .  
  .        

  ,    . 
 

 

!         
,        . 

    

1.      
    (  ). 

: ,      
   . 

 

2.        . 



  

      |   237 

    

1.        
. 

 

 

 

 

 

2.      . 

3.     : 

■   Tezfel    ,   
 . 

 

■      . 

        
,   –      ,   
  BioFrac™. 



A   |      

238   |     NGC™    ChromLab  

    

           
  NGC  . 

    

1.     Shut Down     
   ChromLab    NGC. 

2.          
   . 

       . 

 

3.   ,    . 



  

      |   239 

4.       ,   
   . 

 

 

 

 
 

 

 
 

 

:       . (  NGC 
Discover™ -  ).       

 .  NGC Quest™  NGC Scout™    . 
        . 

5.  ,          
 . 

:    .      
 . 



A   |      

240   |     NGC™    ChromLab  

 

6.         . 

7.    ,  «Pumphead» (  ), 
        . 

 



  

      |   241 

8.      . 

 

9.        ,   
 . 

10.           
 NGC. 

 



A   |      

242   |     NGC™    ChromLab  

11.    7/64   ,   
   . 

 

12.       ,  
     ,     . 

 

13.      .   
     . 



  

      |   243 

14.      180°,    
   ,          

 . 

15.    ,    12,    
     . 

16.         7/64. 

17.   ,      ,  
      . 

18.      . 

 

19.        ¼ -20  ¾ "   
   . 



A   |      

244   |     NGC™    ChromLab  

20.         . 

 

21.       ,     
 5  . 239. 

22.             
       6-32 x 1¼". 

 

23.       ,    
  . 

24.          
        . 



 

      |   245 

     
 

         
   NGC.      

 ,   Consult Bio-Rad   www.bio-rad.com. 

         
 . 

:         Bio-

Rad,     BioFrac ™   C-96,   
 . 

      

      

  
  

 . 

,   
. 

 .  
 ChromLab   Tools > 

Calibrate > Pump Flow Rate. 
  , 

   . 

    
. 

■   ChromLab ,  
   

  
. 

■ ,   
  

   
. 



B   |       

246   |     NGC™    ChromLab  

      

  
  

  
( ). 

   
 . 

 

:  
   

 . 
■    

    5 
«     
NGC»  . 76.  

■    
   

   7 
«   

 »  . 78. 

     
,    

    
 . 

■ ,   
     

   . 
■     

   
  , 

   
  . 

 ,     
. 

,     
: 

■ ,    
   . 

■ ,    
   

    
  NGC. 

:    
     

 . 
■    

   
. 

■     
 . 

■   , 
    

,    
. 

   
   

«    » 
 . 118. 



      

      |   247 

      

  
  

  
( ). 

     
,   

 . 
:   

   
   

     
20 . 
 

:   
     

 ,  
   

  . 

■   , 
,    

    
   . 

■   , 
    
,    

. 
   

   
«    » 

 . 118. 



B   |       

248   |     NGC™    ChromLab  

      

  
  

  
( ). 

    
 . 

:   
    

   
    

 ,   
 . .  14 

«   
  NGC»  

. 152. 

■   
    

   
    
   

 . 
■   CIP 

(   )   
   
 . 

   
   

   
  NGC 

   
ChromLab. 

■   . 
. «  »  . 

159. 

■   . 
. «  »  . 

159. 

 

:  
   

    
 .   

ChromLab  Tools > 
Calibrate > Pump Flow Rate. 

  , 
   . 

  
   
  

  
. 

   
  . 

   
 . 

:  
   

 .   
ChromLab  Tools > 
Calibrate > Pump Flow Rate. 

  , 
   . 



      

      |   249 

      

  
   
  

  
 ( ). 

   
. 

    
  

. 
 

:  
   

  .   
ChromLab  Tools > 
Calibrate > Pump Flow Rate. 

  , 
   . 

     
 . 

   
  . 

:  
   

 .   
ChromLab  Tools > 
Calibrate > Pump Flow Rate. 

  , 
   . 

   
   
 . 

   
 . 

,   
   . 

      
. 

   
  ,   

  . 

    
. 

 

:   
     

    
 . 

  . 
. «  »  
. 159. 



B   |       

250   |     NGC™    ChromLab  

      

   
   
  

( ). 

    
 . 

■   CIP 
(   )   

 . 
   

   
   

  NGC 
   

ChromLab. 

■   . 
. «  »  
. 159. 

   
(psi/ ./ . .)  

  
 . 

,   . ,   , 
    

    
.    

 . 

      
    

 . 

  ChromLab  
  Sample Inject 

Valve (  )  
,    

  ,    
. 

 ,   
   

    
,    

 . 

    
   

   
,    

    
  . 

 

:  
   

.   ChromLab 
 Tools > Calibrate > Pump 

Flow Rate.   
,   
 . 



      

      |   251 

      

  
   

. 

,   
 . 

  ChromLab ,  
    

 . 
:  
   

.   ChromLab 
 Tools > Calibrate > Pump 

Flow Rate.   
,   
 . 

     
 . 

■    
 ,  

,   
   . 

■     
   
  . 

:  
   

.   ChromLab 
 Tools > Calibrate > Pump 

Flow Rate.   
,   
 . 

    
. 

■     
. 

■    
. 

:  
   

.   ChromLab 
 Tools > Calibrate > Pump 

Flow Rate.   
,   
 . 



B   |       

252   |     NGC™    ChromLab  

      

  
   

 
( ). 

  .     
  . 

:  
   

.   ChromLab 
 Tools > Calibrate > Pump 

Flow Rate.   
,   
 . 

   
 . 

  ChromLab   
   

. 

     
   . 

:   
   

    
    

 . 

,   
 .  

   
      

   . 

   
 . 

    
  . 

,    
  , 

  . 

   
  

. 

   
    

. 

   
. 



-    

      |   253 

-    

      

  
  

. 
 

  
 

 
  

 . 

    
. 

:  
  

   . 

■    
   

  
    

 20 . 
:   

     
 ,  

   
  . 

■    
    

  . 
   

   
   
. 

■   
  20 

./ . .,   
 NGC,   
   

.   
  

  
 

    
    

 . 
    

    
 ,  

   
  

( ,    
  

),  
    

  2 .  
    

  . 



B   |       

254   |     NGC™    ChromLab  

      

  
  

 ( ). 
 

  
 

 
  

  
( ). 

 -   
  

     
. 

     
  System 

Information: 

1.   System Control  
 ChromLab  File > 

System Information >  
Detector. 

2.   Get Lamp Status 
(   ). 

    
(2000     

 ; 5000  
  ). 

   
  -  
   «  
  - » 

 . 196. 
  : 

■ . «   
  -

»  . 201 

■ . «   
 

 » 
 . 209 

:  
   Detector 

   «  
»  

   
  NGC 

   
ChromLab. 

  
   

   
 . 

    
   

 , 
    

 . 

    
   
. 



-    

      |   255 

      

  
 

  
. 

   
    . 

   
   
  ( , 

  20-30 ),   
    

   
 NGC  

,    
  . 

    
,   . 

  
  
  . 

■     
. 

■   . 

■    
   

   1 M 
  (NaOH), 

,  /  0,5  
HMnO3,   

 . 
   
   

   
(    
« »  , 

     
 ). 

:    
 2   Contrad 

( . № 176-4118)    
 10 .   

    
20% . 
■    

    
  , 
,    
   

 . 
   

  
   

  
. 



B   |       

256   |     NGC™    ChromLab  

      

  
. 

 , , 
-     

  . 

■     
  . 

■   .  
  ChromLab  

Tools > Calibrate > Pump Flow 
Rate.   

,   
 . 

   
. 

  
   

,  , 
  

 .  
 . 

      
  , 

 ,   
  , 

 - . 

     
   

   
   .  

  , , 
  . 

:    
    

  . 

 
 . 

     
 ,   , 

   
  . 

   
   

 . 

     
,   

 . 

 ,   
   

   -
,   . 

   
 . 



-    

      |   257 

      

   
,  . 

   .      
  System 

Information.   System 
Control   ChromLab  
File > System Information > 

 Detectors. 

     
  (  2000 

    
 ; 

 5000   
 ),  

.  
■    

  
  

   «  
  
 - » 

 . 201. 

■     
  

   «  
  

 » 
 . 209. 



B   |       

258   |     NGC™    ChromLab  

  

      

  
   

. 

  
 . 

 
 .  

  ChromLab  Tools > 
Calibrate > Conductivity Monitor. 

  , 
   . 

 

:   
   
    

.   
   
 . 

  
 . 

   
. 

.    
    

 2 «  
   

   F10»  
. 63. 

. «   
»  . 186. 



 pH  

      |   259 

 pH 

      

 pH   
 . 

,   
 pH. 

  pH.   
ChromLab  Tools > 
Calibrate > pH.   

,   
 . 

    
. 

    
   

 . 

■  ,  
  . 

■    
   . 

    
,  

 . 

  .   .     
  . 

: ,  
     

 . 

  
 pH. 

pH-    
. 

   . 



B   |       

260   |     NGC™    ChromLab  

     
 

      

  
    

  . 

   
. 

    
    

 Bio-Rad. 

  к  
 

      

  
 >0-1 ./ . ., 

   
  . 

■   
  

    
 . 

■   NGC 
   

  
 . 

■   
 .   

ChromLab  Tools > 
Calibrate > Column Switching 
Valve Pressure.  

 , 
   

. 
■    

   
   
.   ChromLab 
 Tools > Calibrate > 

Column Switching Valve 
Pressure.   Reset to 
factory (    

). 



  

      |   261 

  

      

  
 , 

   
SIM 1  SIM 2  

  (SIM). 
 

   
 , 

   
SIM 1  SIM 2. 

  
  

   
   

SIM. 

   
   

  SIM 2.  

.  «   
    

SIM 1  SIM 2»  . 107. 

  
  
  

BioFrac™. 

■    
. 

 

■  NGC    
 . 

 

■    
  . 

■    
    

Retry (  )  
  

. 
■    

     
  : 

1.   

2.  NGC  

■    
,   

 . 



B   |       

262   |     NGC™    ChromLab  

 



 

      |   263 

 C   

   ,    ,  NGC™ 
       ,   

  .      
   . 

  ,        
NGC     .     

   . 



C   |     

264   |     NGC™    ChromLab  

  NGC 

       . 
       

.         
 . 

      

 NGC    .    
 18    . 

 18.     NGC  
 

    
 

 /  

 
 

. . 1/8" x . . 
0,062"  

( . . 3,2  x . 
. 1,6 ) 

 

 

  
 . . 

1/8" (3,2 ) 

20  

  
  

 F10 

. . 1/16" x . 
. 0,020"  

( . . 1,6  x . 
. 0,51 ) 

 

PEEK 

  
 . . 

1/16" (1,6 ) 

2  

  
  

 F100 

. . 1/16" x . 
. 0,030"  

( . . 1,6  x . 
. 0,76 ) 

 

PEEK 

  
 . . 

1/16" (1,6 ) 

4,5  

:         
.    .      

 .  Bio-Rad    
    .   ,   
 6",          

      . 



  NGC 

      |   265 

     
  NGC 

 19       NGC.  
     . 

 19.       NGC 
 

  

1.   –        
  A 

2.       –    
      B 

3.  1/4-28 –       B 

4.        –   
1/4-28,        

    B 

5.   : 
■   

■  

■   (2) 

6.  2       – 
    20 ./ . . 

     

   NGC      
  ,      .  

         (   
   ).        

   ,     
     . 



C   |     

266   |     NGC™    ChromLab  

    
 

     

 
  A   B    

 

     
 

   
 

   
 

 
    



  NGC 

      |   267 

        
 

1.            
  . 

2.   50  20%       
.  

:      20% . 

3.          (  
 )    A. 

 

 

 

  
  

  

4.            
  20% . 

5.          
(   )   . 

6.   1/4-28        
           
  . 

7.   1/4-28    .    
         B. 

:        . 
  ,       12    

     . 



C   |     

268   |     NGC™    ChromLab  

8.   30        1/4-28   
        . 

9.   ,      . 

10.           
       B. 

11.       1/4-28,     
 7. 

12.           
  . 

13.         20% . 

     

 ,    «      
   »  . 267,   : 

►           , 
       -    

. 



  NGC 

      |   269 

   

    

1.      Waste 1  Waste 2   
. 

2.       . 
 

 

 
 
 

3.      Loop E  Loop F   
. 



C   |     

270   |     NGC™    ChromLab  

   

    ,    
. 

    

1.   2     . 

2.     2    20 ./ . . 

:     . ,   
      . 

 



  NGC 

      |   271 

  NGC Quest 

 20      NGC Quest™.  
     . 

:   ,      
,    «     

   NGC»  . 265. 

 20.      NGC Quest 
 

  

1.   –      A 

2.   –      B 

3.  4    20 ./ . . –    
Common      BioFrac™  

  . 272   Point-to-Plumb™   NGC 

Quest. 



C   |     

272   |     NGC™    ChromLab  

 Point-to-Plumb  NGC Quest 

 

 

  

 
 PEEK (  F100) 

  PEEK (  F10) 

 
   

-  

   

 
 Point-to-Plumb™ 

   

  

  
 

 

  

  
 

BIOFRAC™ 

 

  

 B  A 



  NGC 

      |   273 

    

1.         . 
 

 

 

 
 
 

  
 

 
  

 
 

2.         B. 

3.           
 . 

    

1.   4     , 
      2  . 270. 

2.      4   Common    
  BioFrac. 



C   |     

274   |     NGC™    ChromLab  

  NGC Scout 

 21      NGC Scout™.  
     . 

:   ,      
,    «     

   NGC»  . 265. 

 21.      NGC Scout 
 

  

1.   –   Q1-Q4      
 

2.   –      (Cal Out)  
  pH 

3.        –   
   (Cal In)    pH 

4.  2    20 ./ . . –     
  pH 

5.  4       pH –    
Common      BioFrac 

  . 275   Point-to-Plumb™   NGC 

Scout. 



  NGC 

      |   275 

 Point-to-Plumb  NGC Scout  

 

 

  

 
 PEEK (  F100) 

 
 PEEK (  F10) 

 
   

-  

 
  

  Point-to-Plumb™ 

   

    

  

  
 

BIOFRAC™ 
 

 

  

  

 Q   Q  



C   |     

276   |     NGC™    ChromLab  

       

►      Q1-Q4     
 . 

:        
   . 

 

        : 

    

 Q4    

 Q3  

 Q2   

 Q1   

    pH 

1.          Cal In 
   pH. 

2.      Cal Out    . 



  NGC 

      |   277 

 

 

 

  
 

 

   
 

  
 

 

   
 

 
 

3.          . 

4.   2    20 ./ . ., 
   2  . 270,    (In)    

. 

5.   4    (Out)    . 

6.     4   Common    
  BioFrac. 

:     pH       
     –   .   

    ChromLab    ,   
 «     /   » 

      NGC  
  ChromLab. 



C   |     

278   |     NGC™    ChromLab  

     NGC 
Discover 

 22      NGC Discover™. 
      . 

:   ,      
,    «     

   NGC»  . 265. 

 22.      NGC Discover 
 

  

1.   –         
   

2.       –    
        

3.  1/4-28 –         
   

4.   –     1/4-28     

5.   –   Q1-Q4      
 

6.   –       
 

7.   –       

8.   –   Cal Out    . 

9.   –      (Cal In)  
  pH 

10.  2    20 ./ . . –     
  pH 

11.  4    20 ./ . . –    
Common      BioFrac 

  . 279   Point-to-Plumb™   
NGC Discover. 



  NGC 

      |   279 

 Point-to-Plumb  NGC Discover  

 

 

  

 
 PEEK (  F100) 

  PEEK (  F10) 

 
   

-  

   

  Point-to-Plumb™ 

   

    

 

  

 

  

 Q   Q  

  
  

BIOFRAC™ 

 

 

  



C   |     

280   |     NGC™    ChromLab  

       

►      Q1-Q4     
 . 

:        
   . 

 

        : 

    

 Q4    

 Q3  

 Q2   

 Q1   



  NGC 

      |   281 

      

1.     A (Outlet A)     
    8/BB     
 A. 

2.     B (Outlet B)     
    8/BB     
 B. 

 

3.      (Out)    A   
   A. 

4.      (Out)    B   
   B. 

5. ( )      2-7    
   A  B. 

     

1.         . 

2.          
 . 

3.         (Sample Pump)  
 . 



C   |     

282   |     NGC™    ChromLab  

    pH 

1.          Cal In 

   pH. 

2.      Cal Out    . 
 

 

 

 

  
 

 

   
 

  
 

 

   
 

 
 

3.        . 

4.   2    20 ./ . ., 
   2  . 270,    (In)    

. 

5.   4    (Out)    . 

6.     4   Common    
  BioFrac. 



  NGC 

      |   283 

     NGC 
Discover Pro 

 23      NGC Discover Pro. 
      . 

:   ,      
,    «     

   NGC»  . 265  «    
  NGC Discover»  . 278. 

 23.      NGC Discover Pro 
 

  

1.  6 –        
     

:       
  ,   . 

2.     : 
■  4    Common    

 BioFrac –   1   

■   –   1   

3.   –      . . 
 «    »  . 285. 

4.   –     . . 
 «   »  . 286. 

  . 284   Point-to-Plumb™   NGC 

Discover Pro. 



C   |     

284   |     NGC™    ChromLab  

 Point-to-Plumb  NGC Discover Pro 
 

 

  

  PEEK (  F100) 

  PEEK (  F10) 

 
   -

 

   

  Point-to-Plumb™ 

   

    

 

 

   

 

   

 Q   Q  

   

BIOFRAC™ 

 

  



  NGC 

      |   285 

    

        .  
    5' (1,5 ).    

   . 

:   NGC       
. 

 

     

1.         : 

.      (Out)    
      . 

.        1-8. 



C   |     

286   |     NGC™    ChromLab  

2.        : 

.      (Out)    
 1      . 

.      (Out)    
 2 (S2)   8  S1. 

.        1-7  
 S1    1-8   S2. 

3.       . 

   

       .  
    5' (1,5 ).    

   . 

 

    

1.        : 

.      (Out)  
   pH    (In)  . 



  NGC 

      |   287 

. ( )     : 

■   4   1    Common  
    BioFrac. 

■      1       
 . 

.        . 

2.       : 

.      (Out)  
   pH    (In)   1 

( 1). 

. ( )     : 

■   4   1   1    
Common      BioFrac. 

■      1   1    
    . 

.     12   01    (In)  
  2 ( 2). 

.         
 . 

3.        . 



C   |     

288   |     NGC™    ChromLab  

 



 

      |   289 

 D  
 C-96  

 NGC 

  C-96   NGC 

 C-96   ,  
     .   

         
  5   10 . 

   (SIM)   C-96   NGC. 

 SIM      C-96   
     NGC. 

       C-96  
   NGC. 

:        C-96   
 . 

  C-96   NGC 

     NGC 

1. ,    NGC   C-96 . 

2.   SIM   NGC.    
   «   SIM   NGC»  . 105. 

3.     SIM    DIGITAL IN  
   . 

4.    DIGITAL OUT     . 



D   |     C-96   NGC 

290   |     NGC™    ChromLab  

5.   ,     SIM: 

■   15-   D ( . № 10027227) 

■   9-   D ( . № 10027224) 

    . 

6.   DIGITAL IN    15-   D. 

:   15-   D    ( , 
  ). 

.    ,     . 

.    . 

.           
: 

■      . 

■      . 

■       ( ). 
:   . 

7.   DIGITAL OUT    9-   D. 

:   9-   D    (   
). 

.        . 

.           
,     : 

■      . 

■       ( ). 



  C-96   NGC 

      |   291 

8.    : 

.    15-     (P1 RELAYS OUTPUTS) 

    . 

.    9-     (P2 INPUTS)   
  . 

 

15-   
 

9-  
 

 

9.     SIM: 

.    P1 RELAYS OUTPUTS   DIGITAL IN. 

.    P2 INPUTS   DIGITAL OUT. 
 

9-   15-   

 



D   |     C-96   NGC 

292   |     NGC™    ChromLab  

    C-96 

       C-96  
    NGC     

.       
 .       
  1/16" PEEK. 

        
     C-96    

BioLogic DuoFlow™      C-96  
  BioLogic DuoFlow. 

   

1.     1/16" PEEK  . 

2.        10-32.    
    . 

3.        1/4-28.   
    . 

        

1. ,    NGC   C-96 . 

2.    10-32   1 (Port 1)    10-32 –  
 6 (Port 6) . 

3.   1/4-28   1   Loop E   
. 

4.   1/4-28   6   Loop F   
. 

5.    1/4-28   ,    1/4-28 –  
  (W1)   . 

6.    NGC  . 



  C-96   NGC 

      |   293 

     C-96 

:    ,     
 . 

1.            
( , )    . 

2.     .    
   «    »  . 118. 

3.   ChromLab       ChromLab  
 . 

4.         
 . 

 

 

 

 

  

 
 

 

5.          
      . 

6.      System Pump Inject Loop 
(   – ). 

 



D   |     C-96   NGC 

294   |     NGC™    ChromLab  

7.           
     . 

 

8.    System Pump (  ): 

.    (Flow Rate)  5 / . 

. ( )   (Duration)     
2 . 

.   Start. 

 



  C-96   NGC 

      |   295 

  C-96    
       

ChromLab 

         
        ChromLab.   

      ChromLab    
     NGC   

 ChromLab. 

   ,   

1.   ChromLab  ,      
.    (Sample Application)  

  Inject Using Autosampler (   ). 

2.   Sample Application       
     ,   

  6    Loop F  . 

:      2-3     
        . 

3.        C-96. 

        
    C-96    BioLogic 

DuoFlow™      C-96  
  BioLogic DuoFlow. 

4.          
     (REMOTE). 

5.   ChromLab      . 

        
    ChromLab.   (  ,   

 )      (   
    ),   . 



D   |     C-96   NGC 

296   |     NGC™    ChromLab  

 



 

      |   297 

 E   

 NGC™        
       

.  NGC    . 

   

 CE: 

■ EN 61010-1    ,   
  

■ IEC 61010-1      , 
   ,  1   

 cTUVus: 

■ UL STD No. 61010-1    , 
   .  1:   

■ CAN/CSA C22.2 No. 61010-1 -12    
,    .  

.  1:   (   1) 

       
      . 

       
,       . 



E   |     

298   |     NGC™    ChromLab  

     
   .   Ш    

        
  .  Bio-Rad      

    UL61010-1:2012  CSA C22.2 
№61010-1 -12. 

 24.        
 .   Ш    

 

  
 

   
 

5  F10 2 650 / . . 

5  F100 1 400 / . . 

DynaLoop™ 25  F100 700 / . . 

DynaLoop 90  F100 270 / . . 

Э   (Э ) 

 CE: 

■ EN 61326  A    , 
    

 NGC       . 
  , ,     10 

 (3 )  . 



        

      |   299 

     
  Ш  

 NGC   № 15  FCC.   
     : (1)    

     (2)      
,  ,      . 

 ,    NGC      
 ,        . 

          
  . 

         
. 

      : 

■    

■      
IEC/EN/UL/CSA 61010-1 

■    . 

 Bio-Rad Laboratories        
,      ,     

,   ,    Bio-Rad 

Laboratories   . 

:  NGC     . 

     , 
   .     

 , ,      
   . 



E   |     

300   |     NGC™    ChromLab  

 



 

      |   301 

 F   
 

 NGC 

 25.     NGC 
 

   

NGC Quest™ 10 788-0001 

NGC Quest 100 788-0002 

NGC Quest 10 Plus 788-0003 

NGC Quest 100 Plus 788-0004 

NGC Scout™ 10 788-0005 

NGC Scout 100 788-0006 

NGC Scout 10 Plus 788-0007 

NGC Scout 100 Plus 788-0008 

NGC Discover™ 10 788-0009 

NGC Discover 100 788-0010 

NGC Discover 10 Pro 788-0011 

NGC Discover 100 Pro 788-0012 

  BioFrac 741-0002 

 NGC   788-5011 

 NGC   788-5012 

   (SIM) +   
 

788-4016 

  788-4025 



F   |       NGC  

302   |     NGC™    ChromLab  

 



 

 

 

Powered by TCPDF (www.tcpdf.org)Powered by TCPDF (www.tcpdf.org)

http://www.tcpdf.org

